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Any unauthorized reproduction of the Spelling Sentry user's guide or software is strictly prohibited and 
is a violation of national and international copyright laws. No part of this product may be reproduced or 
distributed in any form, by any means, except as described herein.

SPELLING SENTRY IS PROVIDED “AS IS,” WITHOUT WARRANTY OF ANY KIND. 
WINTERTREE SOFTWARE DISCLAIMS ANY REAL OR IMPLIED WARRANTY WITH RESPECT
TO FITNESS FOR ANY PARTICULAR PURPOSE. WINTERTREE SOFTWARE CANNOT BE 
HELD RESPONSIBLE FOR LOSS OR DAMAGE, DIRECT OR INDIRECT, CAUSED BY THE USE 
OR MISUSE OF THIS PRODUCT.

The Spelling Sentry program, the Sentry Spelling-Checker Engine DLL, and the Spelling Sentry user's 
guide are Copyright © 1993 by Wintertree Software Inc.

All trademarks used herein are the property of their respective holders.
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Introduction

Wintertree Software's Spelling Sentry program lets you check the spelling of text files, Windows Write 
files, and text in the Windows clipboard. It comes with a high-quality 100,000-word lexicon 
(dictionary), and includes support for three lexicon types. It's fast, easy to use, and reliable. Here are 
some other features:

• Can replace misspelled words in the file or clipboard text
• Displays the sentence containing a misspelled word so you can see how it is used
• Suggests accurate alternatives for misspelled words
• Displays word and sentence counts plus Fog and Flesch-Kincaid readability scores
• Can ignore capitalized words (e.g., proper names), except when they occur at the beginnings of 

sentences
• Can ignore words containing embedded numbers or special symbols
• Can ignore words containing special upper- and lower-case patterns
• Can detect doubled words
• Can detect words with unusual case combinations
• Can undo the last replacement made in a file or clipboard text
• Includes on-line help
• You can add your own words to three customizable lexicons
• You can save words you frequently misspell for automatic correction or suggestion
• Progress display shows number of words checked and percent complete
• Easy lexicon editing includes merging lexicons or dictionaries from other applications
• Can check the spelling of individual words
• Supports drag-and-drop file checking

At the back of this guide is a glossary which explains many of the terms used.

Special Note to Software Developers
Spelling Sentry uses Wintertree Software's Sentry Spelling-Checker Engine. Software developers can 
license this professional-quality spelling-checker technology for use in applications without royalty or 
run-time fees. For further information, contact Wintertree Software at (613) 825-6271.
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Using Spelling Sentry

How to check a file
Spelling Sentry can check the spelling of ASCII text files and Windows Write files. You can check files 
using two methods: from Spelling Sentry's Check menu and by dragging a file from the Windows File 
Manager.

To check a file using the Check menu
1. From the Check menu, select File.
2. Spelling Sentry displays an Open File dialog. Locate and select the file you wish to check, then 

select the OK button.
3. Spelling Sentry checks the words in the file.
4. Spelling Sentry pauses when it detects a misspelled word so you can correct it. See “How to 

respond to spelling errors” for instructions.
5. When checking is complete, Spelling Sentry saves any replacements made to disk. It also 

displays some statistics (see “Statistics” in the “Spelling Sentry Reference” chapter for details).

To check a file from the File Manager
1. Locate the file you wish to check in File Manager's window.
2. Drag the file from File Manager's window onto Spelling Sentry's window or icon (“drag” means 

click and hold the left mouse-button, move the mouse, then release the mouse button). Note: You
can drag a file to Spelling Sentry's icon only if Spelling Sentry is “minimized” at the bottom of 
the screen.

3. Spelling Sentry checks the words in the file.
4. Spelling Sentry pauses when it detects a misspelled word so you can correct it. See “How to 

respond to spelling errors” for instructions.
5. When checking is complete, Spelling Sentry saves any replacements made to disk. It also 

displays some statistics (see “Statistics” in the “Spelling Sentry Reference” chapter for details).

Notes:
You can cancel a spell-checking session by selecting the Stop button. Spelling Sentry doesn't save any 
changes made to the file until the entire file is checked. If you select the Stop button to terminate 
checking of a file, Spelling Sentry will display a dialog asking if you want to save any changes made up 
to that point..

Spelling Sentry can check files produced by the Windows Write program and ASCII text files. If the file 
you select doesn't appear to be either of these types, Spelling Sentry will display a warning message 
asking if you want to check the file anyway. Spelling Sentry will attempt to identify words in 
unsupported file types, but bear in mind that it may become confused. Replacing misspelled words in 
these files is not recommended.
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How to check the clipboard
You can check the spelling of words in the Windows clipboard.

1. In another application, select the text you want to check, then copy it to the clipboard. You can 
do this in most applications by selecting the Copy item from the Edit menu.

2. In Spelling Sentry, select the Clipboard item from the Check menu.
3. Spelling Sentry checks the words in the clipboard.
4. When Spelling Sentry detects a misspelled word, it pauses so you can correct it. See “How to 

respond to spelling errors” for more information.
5. When Spelling Sentry is finished checking, it copies any replacements made to the clipboard. 

You can paste the corrected text back into your other application's document. You can do this in 
most applications by selecting the Paste item from the Edit menu.

Notes
You can also tell Spelling Sentry to check the clipboard by selecting the Check Clipboard item in 
Spelling Sentry's System menu. If Spelling Sentry's window is visible, you can open the System menu 
by clicking on the box at the upper-left corner. If Spelling Sentry's window is minimized, you can open 
the System menu by clicking on Spelling Sentry's icon.

You can cancel a spell-checking session by selecting the Stop Checking button. Spelling Sentry doesn't 
save any changes made to the clipboard until the entire clipboard is checked. If you select the Stop 
button to terminate checking, Spelling Sentry will display a dialog asking if you want to save any 
changes made up to that point.

How to check a single word
1. Select the Word item from the Check menu.
2. Spelling Sentry displays a form which prompts you to enter a word. Type in the word you want 

to check, then select the OK button.
3. Spelling Sentry displays a message which tells you whether the word is correctly spelled or not.

How to respond to spelling errors
When Spelling Sentry detects a misspelled or badly formed word while checking a file or the clipboard, 
it pauses to give you a chance to respond. 

The word which Spelling Sentry considers to be incorrect appears in the Problem Word field in the main
window. The Problem Word field is indicated with one of the following labels, depending on the nature 
of the problem detected by Spelling Sentry:

• Misspelled Word: The word was not found in any of Spelling Sentry's lexicons, and so is 
considered misspelled.

• Doubled Word: The same word appears twice in a row.
• Mixed-Case Word: The word uses an unusual combination of upper- and lower-case letters.
• Consider Replacing: The word was found in a Suggest-Type lexicon. The word in the Correction 

field is a suggested replacement.
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The words surrounding the misspelled word (usually the sentence in which the word appears) are shown 
in the Context area near the top of Spelling Sentry's window. The erroneous word is highlighted in the 
Context area.

If you have selected the Always Suggest option (see “How to set preferences”), Spelling Sentry searches
for alternative spellings for the misspelled word, and displays any suggested words in the list box. If you
have not selected Always Suggest, you can press the Suggest button. This will cause Spelling Sentry to 
search for alternative words. If the correct spelling doesn't appear in the list, try selecting the Suggest 
button again. Each time you select the Suggest button, Spelling Sentry searches its lexicons a little 
deeper.

Select one of the following actions:
• If the word reported by Spelling Sentry is correctly spelled and probably doesn't occur again in 

the file or clipboard, select the Ignore button.
• If the word is correctly spelled and probably occurs again in the file or clipboard, select the 

Ignore All button. If the word appears again, Spelling Sentry will ignore it.
• If the word is correctly spelled and is a word you use often (for example, your family name), 

select the Add to Lex button. Spelling Sentry will remember the word in the Ignore-Type 
lexicon.

• If the word is misspelled and the correct spelling appears in the list box, select the correct 
spelling from the list box.

In some rare cases, Spelling Sentry cannot locate the correct spelling for a misspelled word. If this 
happens, you can edit the word in the Correction field manually. To verify that the word in the 
Correction field is correctly spelled, select the Recheck button. Spelling Sentry will display a message 
telling you if the word is correctly spelled or not.

You can replace the misspelled word in the file or clipboard with the word in the Correction field by 
selecting one of the following actions:

• If the misspelled word doesn't occur again in the file or clipboard, select the Replace button.
• If the misspelled word occurs again in the file or clipboard, select the Replace All button. 

Spelling Sentry will replace this occurrence and each subsequent occurrence of the misspelled 
word with the word in the Correction field.

• If you want Spelling Sentry to “permanently” remember to replace the misspelled word, hold 
down the Shift key when you select the Replace All button. Spelling Sentry will add the word 
and its replacement to the Change-Type lexicon.

Note: By selecting the Undo Last button, you can undo the last single replacement made to the file or 
clipboard.

How to edit a lexicon
You can edit the words in the Change-Type, Ignore-Type, or Suggest-Type lexicon. However, you 
cannot edit the words in Spelling Sentry's main lexicon. See the Glossary at the end of this user's guide 
for a description of the different lexicon types.
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1. Select the item in the Lexicon menu for the lexicon you wish to edit (Change-Type, Ignore-Type,

or Suggest-Type).
2. The lexicon-editor dialog appears. Edit the lexicon by following one of the specific procedures in

this section.
3. To close the lexicon-editor dialog, select the Close button.

How to add a word to a lexicon
1. Select the Add button from the lexicon-editor dialog.
2. A dialog appears, prompting you to enter a word. Enter the word you wish to add. Change-Type 

and Suggest-Type lexicons contain words and their replacements, which must be entered like 
this: word:replacement. For example, to enter “the” as a replacement for “teh”, enter the 
following: teh:the.

3. Select the OK button. Spelling Sentry adds the word to the lexicon.

How to delete a word from a lexicon
1. In the list box in the lexicon-editor dialog, select the word you wish to delete.
2. Select the Delete button. Spelling Sentry removes the selected word from the lexicon.

How to merge two lexicons
You can merge any set of words into a lexicon, provided the words are stored in a disk file. You can use 
this procedure to merge the user lexicon from another application's spelling checker (sometimes called 
the “user dictionary,” “custom dictionary,” etc.) into one of Spelling Sentry's lexicons. However, when 
merging into the Change-Type or Suggest-Type lexicon, the words being merged must be in the 
word:replacement form (see “How to add a word to a lexicon” for an example).

1. Select the Merge button in the lexicon-editor dialog.
2. A file-open dialog appears. Locate and select the file containing the words you wish to merge 

into the current lexicon, then select the OK button.
3. The words in the disk file are merged into the current lexicon.

How to clear a lexicon
1. Select the Clear button from the lexicon-editor dialog. Spelling Sentry displays a dialog asking 

for confirmation. Select the Yes button to proceed.
2. All the words in the current lexicon are deleted.

How to set preferences
You can change the way Spelling Sentry operates to suit your personal preference.

1. Select the Preferences item in the Options menu.
2. The Preferences dialog appears. Select the check boxes in the dialog to enable or disable 

preferences as follows:

Ignore capitalized words: Spelling Sentry will skip any words which start with a capital letter, 
unless the word is the first word in a sentence. This option is useful if your document contains 
many proper names.
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Ignore words with numbers/symbols: Spelling Sentry will skip any words which contain 
embedded numbers or other non-alphabetic symbols Examples: K2J, X11, DOS6.

Ignore words with mixed case: Spelling Sentry will skip any words which have an unusual case 
combination. Examples: YearToDate, CoLA, WordProc.

Report words with mixed case: Spelling Sentry will report words which contain unusual 
combinations of upper- and lower-case letters, even if the words are otherwise spelled correctly. 
Examples: PrintScreen, hAppy, CodeHead.

Report doubled words: Spelling Sentry will report any word which appears twice in a row, unless
the first word appears at the end of a sentence. Example: the the.

Always suggest: When this option is selected, Spelling Sentry will always suggest alternative 
words when a misspelled word is detected. If this option is disabled, you can obtain suggested 
words by selecting the Suggest button. Disabling this option will make Spelling Sentry run faster.

Make backup copy of changed files: When this option is selected, Spelling Sentry will make a 
backup copy of any disk files changed using the Replace or Replace All buttons. The backup 
copy will have the same name as the original file, but it will end in .BAK. For example, if you 
replace words in a file called CHAP1.WRI, Spelling Sentry will leave the original contents in a 
file called CHAP1.BAK.

Spelling Rules: If you prefer spelling words in the American style (e.g., color, defense, traveled), 
select the American button. If you prefer the British style (e.g., colour, defence, travelled), select 
the British button. Note: You must restart Spelling Sentry after you change the spelling rules for 
the new selection to take effect.

3. Once you have made your option selections, select the OK button.

How to exit Spelling Sentry
To exit Spelling Sentry, select the Exit item from the File menu.
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Spelling Sentry Reference

File Menu
The File menu contains file-related commands.

Check: Causes Spelling Sentry to check the spelling of words in an ASCII text file or Windows Write 
file.

Exit: Terminates the Spelling Sentry program.

Check menu
The Check menu contains entries which cause Spelling Sentry to check the spelling of files, the 
clipboard, or individual words.

File: Causes Spelling Sentry to check the spelling of words in an ASCII text file or Windows Write file.

Clipboard: Causes Spelling Sentry to check the spelling of words contained in the Windows clipboard.

Word: Causes Spelling Sentry to check the spelling of a single word.

Options menu
The Options menu contains a single item, Preferences, which you can use to display a dialog to edit 
Spelling Sentry's options. For more information, see the “How to set preferences” section in the “Using 
Spelling Sentry” chapter.

Lexicon Menu
The Lexicon menu contains items you can select to edit the Change-Type, Ignore-Type, or Suggest-Type
lexicon.

Change-Type Lexicon: Displays a dialog you can use to edit the Change-Type lexicon.

Ignore-Type Lexicon: Displays a dialog you can use to edit the Ignore-Type lexicon.

Suggest-Type Lexicon: Displays a dialog you can use to edit the Suggest-Type lexicon.

See the Glossary at the back of this user's guide for a description of the different lexicon types.

Help Menu
The Help menu contains items you can select to obtain information on using Spelling Sentry.

Index: Select this item to access Spelling Sentry's on-line help.

Search for help on: Displays a dialog you can use to search for topics in Spelling Sentry's on-line help.
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About: Displays a dialog which shows copyright information and the version number of the Spelling 
Sentry program and the Sentry Spelling-Checker Engine DLL.

Main Window
This section describes the buttons and controls appearing in Spelling Sentry's main window.

Context Area: The area at the top of Spelling Sentry's window, just below the menu bar, shows the 
context in which a misspelled word is found. Usually, the context is the sentence containing the word. 
Note that Spelling Sentry doesn't apply any corrections made to a file or clipboard until the entire 
document is checked, so replacements will not appear in the context area.

Problem Word Field: Shows the word which requires your attention. This field will be labeled 
“Misspelled Word,” “Doubled Word,” “Mixed-Case Word,” or “Consider Replacing,” depending on the 
specific problem detected.

Correction Field: Contains a replacement for the misspelled word. You can enter a correction word by 
typing it through the keyboard, pasting it from the clipboard (press Ctrl+V), or by selecting one of the 
suggested words in the Suggestions List Box (see below).

Suggestions List Box: Contains suggested alternative words which Spelling Sentry recommends as 
replacements for the misspelled word. When you select a word in the list box, it is automatically copied 
to the correction field (see above).

Add to Lex Button: Adds the word in the Problem Word field to the Ignore-Type lexicon. Use this button 
if the word which Spelling Sentry flagged as misspelled is actually correctly spelled, and is a word you 
use frequently.

Recheck Button: Causes Spelling Sentry to check the spelling of the word in the Correction field. 
Spelling Sentry displays a message indicating whether the word is correctly spelled or not. Use this 
button if you type in a word to replace the misspelled one, and want to double-check the spelling.

Suggest Button: Causes Spelling Sentry to search for replacements for the word in the Problem Word 
field. Use the Suggest button if you want Spelling Sentry to look up the correct spelling for a misspelled 
word. Any suggested replacements found will be displayed in the Suggestions List Box. Pressing the 
Suggest button again may yield better suggested words. When the Suggestion button is disabled 
(grayed), no further suggestions can be located.

Ignore Button: Causes Spelling Sentry to skip this occurrence of the word in the Problem Word field. 
Use the Ignore button if the word is actually correct.

Replace Button: Causes Spelling Sentry to replace the word in the Problem Word field with the word in 
the Correction field. Only this occurrence of the word is replaced. Use the Replace button if the 
misspelled word isn't likely to appear again in the file or clipboard.

Ignore All Button: Causes Spelling Sentry to ignore this and all further occurrences of the misspelled 
word in the file or clipboard. Use the Ignore All button if the word in the Problem Word field is actually 
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correctly spelled and probably occurs again in the same file or clipboard. Selecting the Ignore All button 
with the Shift key held down adds the word in the Problem Word field to the Ignore-Type lexicon.

Replace All Button: Causes Spelling Sentry to replace this and all further occurrences of the misspelled 
word with the word in the Correction field. Use the Replace All button when the misspelled word is 
likely to occur again in the same file or document. Selecting the Replace All button with the Shift key 
held down adds the word in the Problem Word field and the word in the Correction field to the Change-
Type lexicon.

Delete Button: Causes Spelling Sentry to delete the second occurrence of a doubled word.

Stop Button: Causes Spelling Sentry to cancel a file check or clipboard check in progress.  Spelling 
Sentry displays a dialog asking if you want to save any changes made up to this point..

Words Checked Field: Displays the total number of words checked in a file or clipboard. The number 
just to the right of this field shows what portion of the file or clipboard has been checked, expressed as a 
percentage.

Statistics
When Spelling Sentry has completed checking a file or the clipboard, it displays some statistics.

Words Checked: The total number of words in the file or clipboard.

Sentences: The approximate number of sentences in the file or clipboard. Spelling Sentry counts 
sentences by recognizing sentence-terminating punctuation (i.e., periods, question marks, and 
exclamation marks).

Flesch-Kincaid Readability Grade: A score indicating the readability of your writing, expressed as the 
approximate number of years of schooling needed to understand it.

Fog Index: Another readability score, also expressed as the number of years of schooling needed to 
understand your writing.
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Glossary

This section defines some of the terms used in this user's guide.

Alternative word Spelling Sentry can suggest alternative words which are likely 
replacements for a misspelled word. For example, if the misspelled word 
is “stopp,” Spelling Sentry might suggest “stop,” “steppe,” “stopped,” etc.

Change-Type lexicon Words in the Change-Type lexicon are considered misspelled, and 
will be replaced with another word. A Change-Type lexicon contains word
pairs: the misspelled word and its replacement. Use the Change-Type 
lexicon to hold words you frequently misspell or mistype. Spelling Sentry 
will automatically substitute the correct replacement.

Ignore-Type lexicon Words in the Ignore-Type lexicon are considered correctly spelled. 
Spelling Sentry skips any words it finds in the Ignore-Type lexicon.

Lexicon A lexicon is a set of words. Some spelling checkers use the 
term “dictionary” to describe the set of words they use.

Main lexicon The main lexicon is a large collection of commonly used 
English words. The main lexicon is compressed and cannot be edited. A 
100,000-word main lexicon is provided with Spelling Sentry.

Misspelled word Spelling Sentry considers a word to be misspelled if it does not 
exist in any of the lexicons.

Suggested word See Alternative word.

Suggest-Type lexicon A word appearing in a Suggest-Type lexicon will be offered as a 
candidate for replacement. You can make the replacement by selecting the 
Replace button, or skip it by selecting the Ignore button. Use the Suggest-
Type lexicon to add words which may be misspelled or inappropriate in 
some circumstances. For example, if you frequently confuse your and 
you're, add these words to the Suggest-Type lexicon. Whenever you use 
them, Spelling Sentry will remind you to double-check the meaning.
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